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UP Template Version: 11/30/06
Note to the Author

[This document is a template of a Project Management Plan document for a project. The template includes instructions to the author, boilerplate text, and fields that should be replaced with the values specific to the project.

· Blue italicized text enclosed in square brackets ([text]) provides instructions to the document author, or describes the intent, assumptions and context for content included in this document.

· Blue italicized text enclosed in angle brackets (<text>) indicates a field that should be replaced with information specific to a particular project.

· Text and tables in black are provided as boilerplate examples of wording and formats that may be used or modified as appropriate to a specific project.  These are offered only as suggestions to assist in developing project documents; they are not mandatory formats.

When using this template for your project document, it is recommended that you follow these steps:

1. Replace all text enclosed in angle brackets (e.g., <Project Name>) with the correct field values. These angle brackets appear in both the body of the document and in headers and footers.  To customize fields in Microsoft Word (which display a gray background when selected):

a. Select File>Properties>Summary and fill in the Title field with the Document Name and the Subject field with the Project Name.  

b. Select File>Properties>Custom and fill in the Last Modified, Status, and Version fields with the appropriate information for this document. 

c. After you click OK to close the dialog box, update the fields throughout the document with these values by selecting Edit>Select All (or Ctrl-A) and pressing F9.  Or you can update an individual field by clicking on it and pressing F9. This must be done separately for Headers and Footers.

2. Modify boilerplate text as appropriate to the specific project. 

3. To add any new sections to the document, ensure that the appropriate header and body text styles are maintained.  Styles used for the Section Headings are Heading 1, Heading 2 and Heading 3.  Style used for boilerplate text is Body Text.

4. To update the Table of Contents, right-click and select “Update field” and choose the option- “Update entire table”

5. Before submission of the first draft of this document, delete this “Notes to the Author” page and all instructions to the author, which appear throughout the document as blue italicized text enclosed in square brackets.]

6. The table below outlines the differences between the full template and the lite template. It is at the discretion of the project manager to determine which template is most appropriate for their project. If appropriate a subset of the full template may be used however, this lite template represents what should be considered minimum best practice.

7. Upon completion of a project that has utilized lite templates the project manager has a responsibility to circle back and improve project documentation for the purpose of providing a complete historical archive of project activities.
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1 Introduction

1.1 Purpose of LITE Project Management Plan

[Provide the purpose of the LITE Project Management Plan (PMP). This document should be tailored to fit your particular NC project needs.  The detail provided in each section depends on the class of the project. For more complex projects additional documents such as a Risk Management Plan and a Cost Management Plan are recommended in addition to the PMP and should be listed below.]

The <Project Name> LITE Project Management Plan (PMP) is the main planning document for all classes of projects and describes how major aspects of the project will be managed.  It further refines and advances the approaches that were defined during the Initiating Phase. The PMP is a living document and should be updated continually throughout the project.
The intended audience of the <Project Name> LITE Project Management Plan is all project stakeholders including the project sponsor, senior leadership and the project team.

2 project And Product Overview

[Provide a brief description of the project and its associated product. Also briefly state the business need for the project, its public health/business impact, and how the project goals align with the goals of the NC, Division, and/or Branch.  The information  included in the Project and Product Overview section of the LITE Project Charter may be cut and pasted here as is, or may be further refined and detailed here as appropriate.]

3 ScoPE

3.1 Objectives

[Describe what the project is intended to achieve, in business and technical terms.  The information included in the Objectives section of the LITE Project Charter may be cut and pasted here as is, or may be further refined and detailed here as appropriate.]

3.2 High-Level Requirements

[Describe the functions that must be in place when the project is complete.  The level of detail in this section will vary based on the complexity of the project and the persons involved in the development of the Project Management Plan.  The information included in the High-Level Requirements section (Section 3.2) of the LITE Project Charter may be cut and pasted here as is, or may be further refined and detailed here as appropriate.]

3.3 Assumptions

[State any assumption(s) that would have significant impact on the project if proven incorrect. Assumptions are circumstances and events that need to occur for the project to be successful, but are outside the total control of the project team.]  

3.4 Constraints

[List any constraints that must be taken into consideration prior to the initiation of the project.  A constraint is anything that might restrict, limit, or regulate the project. Generally constraints are outside the total control of the project team.]

3.5 Major Deliverables/Milestones
[Provide a list of the major deliverables that will be completed by the end of this project. A deliverable is a tangible, verifiable outcome of work that achieves an objective. The existence of one or more deliverables proves that an objective has been reached. To be verifiable, the deliverable must meet predetermined standards for its completion, such as a design specification for a product or a checklist of steps that is completed as part of a service. Certain projects may chose to focus on overall product deliverables as opposed to individual project deliverables.  The information included in the Major Deliverables/Milestones section of the LITE Project Charter may be cut and pasted here as is, or may be further refined and detailed here as appropriate.  Alternatively, projects may choose to use the Work Breakdown Structure as referenced in the section below to document the project’s major deliverables.]

3.6 Work Breakdown Structure

[Insert the project’s Work Breakdown Structure or provide a reference to where it is stored.  See the CDC UP Work Breakdown Structure Practices Guide for a sample WBS template.]
4 Compliance Related Planning

[Delineate the compliance related processes that the initiative will follow. To assist with this section, CDC UP Process Guides are available on the CDC UP web site (http://intranet.cdc.gov/ncphi/cdcup/) to provide additional information and guidance on following compliance related processes. Compliance related processes may include: 

· Capital Planning and Investment Control (CPIC)

· Security (including the C&A process)

· Enterprise Architecture

· Section 508 Compliance

· Privacy Impact Assessment (PIA)

· PHIN related requirements (PHIN Vocabulary and PHIN Messaging)

· Application and Server hosting requirements (e.g., Secure Data Network, Mid- Tier Data Center, Designated Server Sites and other ITSO requirements)

5 Schedule

5.1 Schedule Management

[Describe who will be responsible for managing the schedule, how frequently it will be updated, how any variances will be addressed, and what will be considered an unacceptable variance. Schedule management is the process of ensuring that the project schedule is base lined, maintained, and managed.  Any unacceptable increase in schedule should be reviewed according to the project’s Change Control processes.
Here’s one example of a schedule management approach: Establish a baseline within the first two weeks of the project and monitor progress against the baseline on a weekly basis. The Project Manager will be responsible for ensuring the project schedule is updated with the latest information and is never more than three business days out of date. 
See the CDC UP Project Schedule Practices Guide for more guidance on project schedules and for sample Project Schedule templates.]
5.2 Project Schedule

[A project schedule is the agreed upon set of tasks and due dates used to guide and monitor the project to completion. Provide the project schedule or provide a link or reference to the project’s schedule.  A project schedule is the agreed upon set of tasks and due dates used to guide and monitor the project to completion.  See the CDC UP Project Schedule Practices Guide for more guidance on project schedules and for sample Project Schedule templates.]
6 budget/Cost 

6.1 Funding Source

[State the source of funding for the project (e.g., grant, terrorism budget, or operational budget).  This information was included in the Funding Source section (Section 6.1) of the Project Charter and may be further refined here as appropriate.] 

6.2 Budget

[Provide the budget for the project. The budget information included in the Budget Estimate section of the LITE Project Charter can be used as a starting point to further refine and develop the budget for the project.]

7 Project Organization

7.1 Roles and Responsibilities

[Describe the roles and responsibilities of the Project Sponsor, Government Monitor, Project Manager, Business Steward, Technical Steward, Security Steward, and Information Systems Security Officer (ISSO).  Depending on your NC or your project organization, you may modify the roles and responsibilities listed in the table below. For example, your project might have a key role that is not listed; it may be added to the list. Additionally, roles may be removed as well.]

This section describes the key roles supporting the project. 

	Name & Organization
	Project Role
	Project Responsibilities

	<Name>

<Org>
	Project Sponsor
	Person responsible for acting as the project’s champion and providing direction and support to the team.  In the context of this document, this person approves the request for funding, approves the project scope represented in this document, and sets the priority of the project relative to other projects in his/her area of responsibility.

	<Name>

<Org>
	Government Monitor
	Government employee who provides the interface between the project team and the project sponsor.  Additionally, they will serve as the single focal point of contact for the Project Manager to manage CDC’s day-to-day interests. This person must have adequate business and project knowledge in order to make informed decisions.

	<Name>

<Org>
	Project Manager (This could include a Contractor Project Manager as well as an FTE Project Manager)
	Person who performs the day-to-day management of the project and has specific accountability for managing the project within the approved constraints of scope, quality, time and cost, to deliver the specified requirements, deliverables and customer satisfaction.  

	<Name>

<Org>
	Business Steward
	Person in management, often the Branch Chief or Division Director, who is responsible for the project in its entirety.

	<Name>

<Org>
	Technical Steward
	Person who is responsible for the technical day-to-day aspects of the system including the details of system development.  The Technical Steward is responsible for providing technical direction to the project.

	<Name>

<Org>
	Security Steward
	Person who is responsible for playing the lead role for maintaining the project’s information security.

	<Name>

<Org>
	Information System Security Officer (ISSO)
	Definition will be provided by OCISO. 


7.2 Stakeholders (Internal and External)

[Provide a list of all the identified project stakeholders, both internal and external to the project.  A stakeholder is a person or organization that is actively involved in the project, and/or that could positively or negatively impact the achievement of the project objectives, and/or whose interests may be positively or negatively affected by the execution or completion of the project.]
8 Risk MANAGEMENT

[It is recommended that a Risk Management Strategy be prepared and a Risk Log be used for ongoing tracking and reporting.  In complex projects, such as those categorized by CPIC as major/tactical, it is recommended that a full Risk Management Plan be prepared. In smaller projects, it may not be necessary to prepare a separate Risk Management Plan if the Risk Management section in the Project Management Plan contains sufficient detail to manage risks associated with the project.]
9 Issue Management

[It is recommended that an Issue Management Strategy be prepared and an Issue Log be used for ongoing tracking and reporting.]

10 Change MANAGEMENT
[Describe the Change Management Process, also known as Change Control, by which change requests will be identified, tracked, approved and prioritized. Change control management is the process of managing changes to the project’s original scope, budget, schedule, or staffing.  It generally involves redefining existing objectives and deliverables or specifying new project objectives and deliverables; which may in turn impact cost, schedule, and/or staffing. This section will describe internal changes to the project. Internal changes are changes that can be resolved by the project team, such as a user requesting a change to the color of a screen. There are two types of External changes.  The first type is when your project will impact a group outside of the current stakeholder group.  These changes must be communicated and approved.  The second type of External change is a change that is initiated by a group outside of the project team, but will impact the project.  For example, if a development server for your project is administered by another organization that is responsible for installing machine upgrades and there are scheduled outages that will impact your project schedule.

In this section, describe the project’s Change Control Process for managing requested project changes. The description should include information about the following: how change requests will be initiated (e.g., via email, or using a change management tool); how change requests will be logged and tracked; how change requests will be assigned for analysis and recommendation (e.g., who compiles the change requests, who determines the level of effort to implement each change); how change requests will be approved (e.g., creation of a Change Control Board); how accepted changes will be integrated into other areas of the Project Management Plan (e.g., schedule, cost, risk, etc.); the roles and responsibilities of participants in the change control management process (e.g., business analysts compile all changes, Project Manager assesses level of effort, and Change Control Board approves/rejects changes or identify key stakeholders who sign off and approve changes); and, how the change process will be communicated to project team members and stakeholders.
A Change Management Log that the project team can use to record details of all changes requested during the project can be downloaded from the CDC UP website.]

11 Communications Management
[Communications management is an integrated approach to conveying clear, consistent and timely information to stakeholders who can affect or may be affected by the objectives and outcome of the project. Also define the approach that will be used to communicate with these stakeholders, including messages, messengers, vehicles, and timing. A Communications Management practices guide, template, and checklist can be downloaded from the CDC UP website at http://intranet.cdc.gov/ncphi/cdcup/.]

12 Quality

 [Describe the approach that will be followed to manage product quality during the project. Quality management is process of defining the strategy and methods the project will deploy to ensure the project’s deliverables are of acceptable quality before they are delivered to the client.  Quality is defined as the totality of features and characteristic of a product that bear on its ability to satisfy stated or implied needs.

Describe what measures of project quality will be used for the project. For an information system, the measure may be no bugs or defects for certain critical requirements, consistent screen layouts, or correctly calculating variables. Some projects might choose to use a traceability matrix to determine if critical requirements have been met.

Next, describe how to assure quality during the project. This involves inspecting the product for quality. One way of doing this is to conduct an audit, which will examine the product at random to see if quality standards are being met. Another way is to have a testing team and a formal approach to testing the product including documenting the defects. In a software development project, for example, controlling the consistency of screen layouts would include reviewing all screens to make sure they match the standards.

Finally, describe how any necessary quality corrections will be implemented. For example, a defect tracking system to ensure defects are fixed, retested and closed. ]

13 Deployment Plan

[This section can be detailed or broad, formal or informal and will describe the approach that will be used to deploy the product or service. For example, if the project involves deploying an application to state health partners, this section would discuss the approach for rolling out the application to the end users, including conducting environment assessments, developing memorandums of understandings, hardware/software installation, and data conversion.] 

Appendix A: Project Management Plan Approval

The undersigned acknowledge they have reviewed the <Project Name> Project Management Plan and agree with the approach it presents. Changes to this Project Management Plan will be coordinated with and approved by the undersigned or their designated representatives.

[List the individuals whose signatures are desired.  Examples of such individuals are Business Steward, Project Manager or Project Sponsor.  Add additional lines for signature as necessary. Although signatures are desired, they are not always required to move forward with the practices outlined within this document.]

	Signature:
	
	Date:
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	Title:
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	Signature:
	
	Date:
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	Title:
	
	
	

	Role:
	
	
	


	Signature:
	
	Date:
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	Title:
	
	
	

	Role:
	
	
	


APPENDIX B: REFERENCES

[Insert the name, version number, description, and physical location of any documents referenced in this document.  Add rows to the table as necessary.] 

The following table summarizes the documents referenced in this document.

	Document Name and Version
	Description
	Location

	<Document Name and Version Number>
	[Provide description of the document]
	<URL or Network path where document is located>


APPENDIX C:  KEY TERMS

[Insert terms and definitions used in this document.  Add rows to the table as necessary. Follow the link below to for definitions of project management terms and acronyms used in this and other documents.

http://www2.cdc.gov/cdcup/library/other/help.htm
The following table provides definitions for terms relevant to this document.

	Term
	Definition

	[Insert Term]
	[Provide definition of the term used in this document.]

	[Insert Term]
	[Provide definition of the term used in this document.]

	[Insert Term]
	[Provide definition of the term used in this document.]
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